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 به نام یگانه معمار هستی

 

، طراحی به روش حالت های حدی به عنوان تنها 2931در مبحث دهم مقررات ملی ساختمان ایران، ویرایش سال 

 AISC. ضوابط این آئین نامه تطابق نسبتاً کاملی با ضوابط آئین نامه ه استروش طراحی سازه های فولادی ارائه گردید

، که بصورت ETABSدر ضوابط لرزه ای دارد. از طرفی نرم افزار  AISC 341-10در طرح المانها و  360-10

ور مناسبی در خود گسترده ای در ایران برای طراحی سازه های متعارف مورد استفاده قرار می گیرد، این ضوابط را بط

بر آن شد  زشهرداری شیرایت کنترل و نظارت ساختمان زه مدیرسا ، کارگروهموضوعداده است. با توجه به این  جای

در زمینه استفاده از این نرم افزار و تنظیمات مربوط به طراحی، هنگام استفاده از روش حالت های حدی،  راهنما ای

 ته وداش مربوطه رم افزارنخواننده آشنایی مناسبی با  آن بوده کهارائه نماید. لازم به ذکر است در این راهنما فرض بر 

 ذکر نشده است. در این راهنما کار با نرم افزارنکات ابتدایی مربوط به  بنابراین

 

 اند: ریبه شرح ز مراجع مورد استفاده در این راهنما

 

1- Steel Frame Design Manual: AISC360-05 / IBC 2006 (2010); Computers and 

Structures Inc. ; Berkeley, California 

2- Technical Note; 2005 AISC Direct Analysis Method (2009); Computers and 

Structures Inc. ; Berkeley, California 

3- AISC 360-10; Specification for Structural Steel Building, American Institute of 

Steel Construction; Chicago, Illinois 

4- AISC 341-10; Seismic Provisions for Structural Steel Buildings, American 

Institute of Steel Construction; Chicago, Illinois 

 

ما از این رو از ش ایهام نیست. و ابهام ،نگارشی فراوان، این اثر مصون از ایرادهایی نظیر غلطهای فنی، هایبا وجود تلاش

نشانی الکترونیکی مراتب را به  بهامو ا کالاش ضا دارد در صورت مشاهده هر گونهگرامی صمیمانه تقا مهندسان

shirazmn.str@gmail.com شود. فراهم آنها برطرف نمودن و شناسایی موجبات تا گزارش فرمایید 
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 ETABS افزار نرم در حدی های حالت روش به فولادی های سازه طراحی و تحلیل مدلسازی، به مربوط نکات

 

آشنایی دارند، با انجام تنظیمات زیر می توانند سازه فولادی  ETABS 9.7.4همکارانی که با طراحی سازه های فولادی به روش تنش مجاز در نرم افزار 

 خود را به روش حالتهای حدی مطابق با مبحث دهم مقررات ملی ایران طرح نمایند.

 

مقادیر جرم واحد حجم، وزن واحد حجم و مدول الاستیسیته فولاد را به قرار شکل زیر  Define > Material Property Dataدر قسمت  -1

می باشد. همچنین در آئین نامه مبحث  ρ =γ/9.81به قرار   (γ)و وزن واحد حجم  (ρ)وارد نمایید. دقت کنید که رابطه بین جرم واحد حجم 

 ذکر شده است. kgf/cmMPa = 20 52.0x10 239000برابر  Eمقدار  1992دهم مقررات ملی سال 

 

 
 (kg-mتعریف مشخصات مصالح فولاد )واحدها بر حسب  (1) شکل

 

سازه فولادی را بدون کنترل ملزومات لرزه ای مندرج در آئین نامه )مانند کنترل فشردگی، کنترل  ETABS 9.7.4در صورتی که بخواهید برنامه  -2

 ،فاصله مهارهای جانبی تیرها، کنترل ضریب لاغری مهاربندها، کنترل نیاز به ورق پیوستگی و ورق مضاعف در قابهای خمشی و ... ( طرح نماید
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در قسمت  Section Designer (SD)ونها اعمال کند، استفاده از مقاطع ساخته شده در برنامهولی ترکیبات بار تشدید یافته را بر روی ست

Define > Frames Sections .بلامانع است 

 

 

 

 توسط برنامه امکان پذیر است. به شرط عدم نیاز به ضوابط لرزه ای Generalیا  SDاستفاده از مقاطع  (2) شکل

 

، مرده دیوار، زنده با امکان کاهش سربار )عمدتاً بارهای زنده با مقدار Super Deadحالتهای بار مورد استفاده مانند بارهای مرده کف، مرده نوع  -9

 Defineت در قسم کیلوگرم بر متر مربع(، زنده بدون امکان کاهش سربار، زنده بام، بار برف، بارهای زلزله، بارهای فرضی و ... را 055کمتر از 

> Static Load Cases .تعریف نمایید 

 

 

 تعریف حالتهای بار (9) شکل
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، ASCE/SEI 7-10و یا آئین نامه  1992دقت نمایید که در ترکیبات بار معرفی شده در مبحث ششم مقررات ملی ساختمان ویرایش سال 

در نظر گرفته شده است. بنابراین ضریب رفتار  1.0ضریب بار زلزله در ترکیبات بار با فرض استفاده از ضریب رفتار سطح طراحی نهایی و برابر 

تقسیم نموده و سپس نیروی زلزله را محاسبه نمود. به عبارت دیگر  1.4ویرایش سوم را می بایست بر عدد  2055سازه مندرج در آئین نامه 

ضریب زلزله ای باشد که قبلاً در روش طراحی به روش تنش مجاز استفاده  1.4یب زلزله مورد استفاده در روش طراحی حدی می بایست ضر

استفاده می  0.1375می شد. بطور مثال اگر ضریب زلزله مربوط به قاب مهاربندی همگرای معمولی در طراحی به روش تنش مجاز قبلاً عدد 

ویرایش چهارم نیازی  2055ضریب رفتار آئین نامه بدیهی است در صورت استفاده از  را وارد کنید. 0.1925ش حدی عدد شد، در طراحی به رو

 به این اصلاح نیست.

 

 

 ضرب شوند. 1.4ضریب بارهای زلزله می بایست در عدد  (4) شکل

 

اعمال بار فرضی مربوط به ناشاقولی  و ویرایش های بعدی( AISC360-05)به بعد  2550در آئین نامه طراحی سازه های فولادی آمریکا از سال 

ر ومجاز ستونها در طرح سازه الزامی شده است. مقدار این بار که بصورت جانبی بر سازه اعمال می شود، ضریبی از کل بار ثقلی می باشد. به ط

و با شرایطی می تواند تنها در ترکیبات بار ثقلی اعمال  (N=0.002 Y)برابر بار ثقلی است  0.002معمول بار فرضی مربوط به ناشاقولی ستونها 

تعریف  Yو دیگری در راستای محور  Xشود. به ازای هر حالت بار ثقلی تعریف شده، کاربر می بایست دو حالت بار فرضی یکی در راستای محور 

 L1  ،L1C  ،L2ال بار مرده و حالتهای باری به نام های برای اعم DWCو  D  ،DC  ،DWنماید. بطور مثال اگر کاربر حالتهای باری به نام های 

 ،L2C و حالتهای بار  برای اعمال بار زندهS  وSC حالت بار ثقلی  11حالت بار فرضی به ازای این  92باشد،  برای تعریف بار برف در نظر گرفته

 Typeبرای هر حالت بار. نوع این بار در قسمت  Yو دیگری مربوط به بار فرضی جهت  Xمی بایست تعریف گردد، یکی مربوط به بار فرضی جهت 

 انتخاب شود. NOTIONALمی بایست  Static Load Casesمربوط به دستور 
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 به ازای هر حالت بار ثقلی Xتعریف حالت های بار فرضی راستای  (0) شکل

 

 

 قلیبه ازای هر حالت بار ث Yتعریف حالت های بار فرضی راستای  (1) شکل

 

را تعریف نمایید. این ترکیبات  1992ترکیبات بار مبحث ششم مقررات ملی ساختمان سال  Define > Load Combinationsدر قسمت  -4

معاونت شهرسازی و معماری شهرداری شیراز تشریح شده است. ذکر چند نکته درباره این  99-152-1بار بطور مفصل در دستورالعمل شماره 

 ز لطف نیست:ترکیبات بار خالی ا
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  1.71 ≥بارهای فرضی مربوط به ناشاقولی ستون می تواند تنها در ترکیبات بار ثقلی وارد شود به شرط آنکهst /Δ2ndΔ  باشد. بطور

 معمول برای اکثر ساختمانها این شرط برقرار است. 

  در ترکیبات بار پیش فرض برنامهETABS 9.7.4  نیز بارهای فرضی تنها به ترکیبات بار ثقلی افزوده می شوند. اما در برنامهETABS 

گزینه ای برای افزودن بارهای فرضی به ترکیبات بار شامل بار زلزله  Steel Frame Design Preferencesدر قسمت  2013

 . (?Add Notional load cases into seismic combos)نیز وجود دارد 

  ضریب بارهای فرضی در یک ترکیب بار دقیقاً مانند ضریب بار ثقلی نظیر است. بطور مثال اگر در ترکیب بار ثقلی ضریب بار زنده برابر

 است. 1.6باشد، ضریب حالت بار فرضی نظیر نیز  1.6

 ل بارهای زنده و مرده یک دفعه در یک ترکیب بارگذاری فقط بار فرضی یک راستا اعمال می گردد. مثلاً برای ترکیب بار ثقلی شام

وارد شوند. همچنین بار جانبی مربوط  Yو بار دیگر بارهای فرضی مرده و زنده جهت  Xمی بایست بارهای فرضی مرده و زنده جهت 

ا هر دو ب Xبه بار فرضی در هر دو راستای یک امتداد می بایست اعمال شود. یعنی یک بار می بایست بار فرضی مرده و زنده جهت 

علامت مثبت و بار بعد هر دو با علامت منفی لحاظ شوند. بنابراین هر ترکیب بار ثقلی با اعمال بارهای فرضی به چهار ترکیب بار 

 تبدیل می شود.

  کیلوگرم بر مترمربع )به شرط آنکه پارکینگ یا  055مطابق آئین نامه در ترکیبات بار شامل بار زلزله، ضریب بارهای زنده کمتر از

 است. 0.5تجمع نباشد( برابر  محل

  در ترکیبات بار معرفی شده توسط آئین نامه مشاهده می شود که بار زنده بام در ترکیبات بارگذاری شامل بار زلزله وجود نداشته و

 وارد شده است. 0.2بجای آن بار برف بام با ضریب 

  جهت های متعامد نیز  %95و  %155یافته می باید اثر  در ترکیبات بار تشدید 1992مطابق مبحث دهم مقررات ملی ساختمان سال

 اثر نمی کند. آنبه   0Ωاعمال گردد. در این ترکیبات بار، زلزله راستای قائم نیز وارد شده ولی ضریب 

  اگر بخواهیم خود نرم افزارETABS  ه محاسبستونها را برای زلزله تشدید یافته با در نظر گرفتن اثر زلزله های متعامد بطور صحیح

زلزله های متعامد تعریف کرده و سپس در ترکیبات  %95یک راستا و  %155نماید، ابتدا می بایست ترکیب بارهایی فقط شامل زلزله 

 بار دیگری، این ترکیب بار شامل زلزله را با بارهای ثقلی ترکیب نماییم.

 

 Do Not Include Specialرا همیشه غیرفعال کنید. به عبارت دیگر گزینه  Define > Special Seismic Load Effectsقسمت  -0

Seismic Design Data .را در این قسمت انتخاب نمایید 

در دو قسمت مختلف از کاربر می پرسد که آیا کنترل های طرح لرزه ای )مثل طرح  ETABS 9.7.4این انتخاب بدان دلیل است که برنامه  

در قسمت  Options( و یکی در منوی Defineدید یافته( را انجام دهد و یا ندهد. یکی در این قسمت )در منوی ستونها برای زلزله تش

Options>Preferences>Steel Frame Design  در منوی .Define  ( چه این گزینه را فعال کنیدInclude ….  و )را انتخاب کنید

صورت گرفته به آن ارجحیت دارد. بطور مثال اگر  Options(، تنظیمی که در منوی … Do Not Includeچه این گزینه را غیرفعال کنید )

 Do Notیا  Includeگزینه  Defineبگویید برنامه کنترل های لرزه ای را انجام دهد، برنامه مستقل از آنکه در منوی  Optionsدر منوی 

Include  دهد. همچنین اگر در منوی را انتخاب کرده باشید، کنترل های لرزه ای را انجام میOptions  بگویید برنامه کنترل های لرزه ای را

را انتخاب کرده باشید، کنترل های لرزه ای را  Do Not Includeیا  Includeگزینه  Defineانجام ندهد، برنامه مستقل از آنکه در منوی 

فعال نمایید، برنامه مقدار  Optionsو هم در منوی  Defineدر منوی انجام نخواهد داد. تنها یک نکته وجود دارد که اگر طرح لرزه ای را هم 

0Ω  را از منویDefine  0قرائت می کند و با مقدارΩ  معرفی شده در منویOptions .کاری نخواهد داشت 
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د، خود تعریف و در برنامه اعمال کننکته بعدی آنکه اگر کاربر بخواهد کنترل های لرزه ای را خودش انجام دهد، مثلاً ترکیبات بار تشدید یافته را 

 طرح لرزه ای برنامه را غیرفعال کند. Optionsو  Defineمی بایست در هر دو قسمت 

 Omega Factorطرح لرزه ای برنامه را فعال نمایید، مانند شکل زیر آن را تکمیل کنید. در قسمت  Defineدر صورتی که بخواهید در منوی 

است. در صورتی که قصد  9و قابهای خمشی عدد  0/2، قابهای دوگانه عدد  2را وارد نمایید. این ضریب برای قابهای مهاربندی عدد  0Ωمقدار 

را  Do Not Include Special Seismic Design Dataدارید کنترل های لرزه ای را بصورت دستی انجام دهید، در این قسمت گزینه 

  انتخاب نمایید.

 

 
 Defineپارامترهای طرح لرزه ای در منوی معرفی  (7) شکل

 

 را مانند روال قبل انجام دهید. Assign، اختصاص های مربوطه در منوی  Defineپس از تنظیم بقیه موارد منوی  -1

فرض  LRFDدر طرح سازه ها به روش  ETABSرا فعال نمایید. برنامه  P-Δانجام تحلیل  Analyze > Set Analysis Optionsدر قسمت  -7

را در لنگرهای بدست آمده  B2می کند نیروهای بدست آمده از تحلیل، نیروهای ناشی از تحلیل مرتبه دوم هستند و بنابراین ضریب تشدید لنگر 

 طراحی نماییم، حتماً باید گزینه مربوط LRFDبه روش  ETABSضرب نمی کند. پس نتیجه می گیریم هرگاه بخواهیم سازه فولادی را در برنامه 

داشتیم. دقت کنید با   ETABSدر برنامه  ASDروند برخلاف روالی بود که در طراحی به روش  را فعال نماییم. این P-Δبه انجام تحلیل 

را انجام نمی دهد. بنابراین برای تشدید لنگر بارهایی که ایجاد حرکت  P-δرا انجام داده ولی تحلیل  P-Δفعال کردن این گزینه برنامه تحلیل 

 را نیاز داریم. B1ی نمی کنند هنوز ضریب جانب
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 P-Δفعال کردن تحلیل  (0) شکل

 

صورت گیرد را وارد نمایید. این ترکیب  P-Δترکیب بار ثقلی ای که می بایست بر اساس آن تحلیل  Set P-Delta Parametersدر قسمت 

برنامه ذکر شده است، می بایست بزرگترین ضرایب مربوط به بار ثقلی در ترکیب بارهای شامل بار جانبی باشد. بطور  Helpبار مطابق آنچه در 

 (1.2D+0.5L+0.2S)باشد، ترکیب بار ثقلی  EE(0.9D)و    EE(1.2D+0.5L+0.2S)مثال اگر ترکیب بارهای شامل بار جانبی بصورت 

حلیلی دقیق و برای ترکیبات بار دوم تحلیلی محافظه کارانه ارائه خواهد کرد. این ترکیب بار ثقلی را در شامل بار زلزله، ت برای ترکیبات بار اول

 قسمت مربوطه وارد کنید.
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 P-Δترکیب بار ثقلی مربوط به تحلیل  (9) شکل

 

 Options > Preferences > Liveدر صورتی که بار زنده شامل کاهش سربار را معرفی کرده اید، برای انجام تنظیمات مربوطه وارد قسمت  -0

Load Reduction  شوید و در این قسمت تنظیمات را مانند شکل زیر انجام دهید. دقت کنید که فرمول کاهش سربار معرفی شده در مبحث

تنها ذکر این نکته  و یا ویرایش های بعدی این آئین نامه تطابق دارد. ASCE7-95دقیقاً با آئین نامه  1992ششم مقررات ملی ساختمان سال 

در نظر می  2و برای همگی تیرها، مهاربندها و دیوارها این ضریب را برابر  4را برابر  LLKبرای همگی ستونها ضریب  ETABSست که برنامه لازم ا

ه ششم در نظر گرفت. این اعداد برای ستونهای کناری با کنسول، تیرهای کناری با کنسول و تیر طره بیشتر از مقداری است که مبحث  گیرد

 فرمول کاهش سربار مطابق مبحث است و بنابراین برای این حالتها می تواند کاهش سربار اعمال شده توسط برنامه کمی در خلاف اطمینان باشد.

 به قرار زیر است: ASCE7-95ششم مقررات ملی و 
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 تنظیمات مربوط به کاهش سربار (15) شکل

 

 Options > Preferences > Steel Frameین نامه طراحی و تنظیمات مربوطه وارد قسمت پس از انجام تحلیل سازه برای انتخاب آئ -9

Design ( تکمیل نمایید. در این تنظیمات به نکات زیر دقت کنید:11شوید. قسمتهای مختلف را مطابق شکل ) 

 

  آئین نامه طراحی راAISC360-05/IBC2006 .انتخاب کنید 

  در تمام انواع قابهایSMF  ،)قاب خمشی ویژه(IMF  ،)قاب خمشی متوسط(SCBF  ،)قاب مهاربندی همگرای ویژه(OCBF  قاب(

)قاب مهاربندی واگرا(، برنامه  EBF)قاب مهاربندی همگرای معمولی با جداگر لرزه ای( و  OCBFIمهاربندی همگرای معمولی(، 

ETABS  کنترل فشردگی مقاطع را قبل از طراحی انجام داده و درصورتی که مقطعی فشرده نباشد، آنرا طراحی نخواهد کرد. تنها

انتخاب کنید، برنامه بدون کنترل ضابطه فشردگی، مقاطع را طراحی می نماید. از نظر فرمولهای کنترل  OMFوقتی که نوع قاب را 

ی انتخابی مختلف وجود ندارد و با تغییر نوع سیستم لرزه بر، تنها کنترلهای مربوط به ضوابط اعضاء فولادی، هیچ تفاوتی بین قابها

 لرزه ای فرق خواهد کرد.

  مقاطعی را که در برنامهSD  تعریف کرده ایم، مقطع نوعGeneral  بوده و از نظر برنامهETABS .این مقاطع غیرفشرده می باشند 

 زه، قاب مهاربندی همگرای معمولی باشد، می توانید نوع قاب را در برنامه در صورتی که سیستم باربر جانبی ساOMF  .انتخاب نمایید

فشردگی مقاطع را کنترل نکرده اما کنترل ستونها تحت ترکیبات بار تشدید یافته را انجام می دهد. مزیت  ETABSبدین ترتیب برنامه 

نیز در طرح اعضاء استفاده نمایید. یادآوری می شود در قابهای  SDبرنامه این روش آن است که می توانید از مقاطع تعریف شده در 

 و مهاربند فشرده باشند. دهانه مهاربندی مهاربندی هم محور با شکل پذیری معمولی، مطابق آئین نامه می بایست مقاطع تیر، ستون

)محدودیت لاغری مربوط به اعضاء با شکل  mdλمی بایست فشرده لرزه ای با محدودیت  0و  7همچنین مقاطع تیر و مهاربند نوع 
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می بایست برای ترکیب بارهای ثقلی و ترکیب بار شامل  0و  7پذیری متوسط( باشند. علاوه بر این تیرهای متصل به مهاربندهای 

ها را می بایست بیشتر شود. در این صورت این کنترل 110نیز نباید از عدد  0و  7نیروی نامتعادل طرح شوند. لاغری مهاربندهای 

 بصورت دستی انجام داد.

 

 LRFDتنظیمات مربوط به طراحی سازه فولادی به روش  (11) شکل



 

 

 معاونت معماری و شهرسازی شهرداری شیراز

 مدیریــت کنتــرل و نظــارت ساختمــان
 

 11 از 11 صفحه

 

49-1 50-2راهنمای شماره   

 ETABSنکات طراحی به روش حالت های حدی در 

 

 

  99-159-1 شماره ، مطابق دستورالعملباشدقاب خمشی با شکل پذیری متوسط یا ویژه  صورتی که سیستم لرزه بر جانبی،در 

بوده و ( Hستونهای ساخته شده از ورق )مثل باکس یا  بایستی مربوطه می ستونها شهرداری شیراز، معاونت شهرسازی و معماری

شکل نورد شده  Iد. همچنین تیرهای اصلی نیز به طور معمول مقاطع نباشاستفاده از پروفیلهای مرکب برای مقطع ستون مجاز نمی 

 I/Wideطع انظیر مق شدهی تعریف از پروفیل ها ETABSدر برنامه . بنابراین در این حالت بهتر است هستندیا ساخته شده از ورق 

Flange  و یاBOX  بدون نیاز به ساختن پروفیلها در برنامه(SD) در قسمت تنظیمات استفاده شده و نوع قاب را IMF  یاSMF 

نیم تا برنامه کنترل های لرزه ای مربوطه را انجام دهد. کنترل هایی را که برنامه در این حالت انجام می دهد عبارتند از انتخاب ک

ترل فشرده لرزه ای بودن تیرها و ستونها، کنترل فاصله مهار جانبی بال تیرها، کنترل ستونها در ترکیبات بار تشدید یافته، کنترل کن

لاغری ستونها در قابهای خمشی ویژه، کنترل ضابطه ستون قوی و تیر ضعیف در ستونهای قاب خمشی ویژه )فقط برای ساختمانهایی 

انتخاب شوند(، کنترل لزوم و طرح ورق پیوستگی و همچنین کنترل تنش برشی و ضخامت ورق مضاعف  Fو  Eکه گروه لرزه ای آنها 

 شکل برای خمش حول محور قوی. Hدر ستونهای با مقطع 

  در صورتی که نوع سیستم لرزه بر جانبی، قاب مهاربندی برون محور باشد، برای آنکه برنامهETABS  بتواند کنترل های لرزه ای

انتخاب کرده و پروفیهای تیر و ستون و مهاربند را یا از  EBFه را انجام دهد، می بایست نوع قاب را در قسمت تنظیمات برنامه مربوط

 مقاطعاستفاده کنیم و یا اگر از پروفیلهای دیگر مثل  BOXو یا  I/Wide Flangeمقطع مثل  ETABSپروفیل های شناخته شده در 

شکل یا دیگر مقاطع شناخته شده  Iاین مقاطع را بصورت مقاطع  PROPERدا با استفاده از برنامه مرکب استفاده می نماییم، ابت

معادل سازی کرده و سپس وارد برنامه نمود تا برنامه بتواند ضوابط طرح لرزه ای را روی آنها کنترل نماید. کنترل  ETABSتوسط 

ستون دهانه مهاربندی و مهاربند،  -ز کنترل فشرده لرزه ای بودن تیر پیوندانجام می دهد عبارتند ا EBFهایی را که برنامه برای قاب 

ستون دهانه مهاربندی، کنترل ستونها در ترکیبات بار تشدید یافته  -مهاربند -تیر خارج پیوند -کنترل ضوابط طرح لرزه ای تیر پیوند

 وابط بصورت دستی بسیار وقت گیر می باشد، برای طرح اینو کنترل دوران تیر پیوند. توصیه می شود با توجه به اینکه کنترل این ض

کنترلهای لرزه ای مربوطه  ETABSنوع قاب حتماً از یکی از دو روش ذکر شده در فوق برای تعریف مقاطع استفاده کرده تا خود برنامه 

 را انجام دهد.

  در قسمتSeismic Design Category  گروه لرزه ای ساختمان را یکی از انواعD  تاF  ًترجیحا(F انتخاب کنید. همچنین در )

مقدار ضریب رفتار نهایی سسیتم لرزه بر را معرفی نمایید. گروه های لرزه ای ساختمانها در آئین نامه بارگذاری  System Rقسمت 

ثر است( و همچنین مربوط به این آئین نامه مؤ Sd1و  Sdsآمریکا بر اساس شدت لرزه خیزی منطقه و نوع خاک )که در پارامترهای 

مربوط به ساختمان با کمترین شدت لرزه خیز و   Aدسته بندی می شوند که  Fتا  Aمیزان اهمیت ساختمان )میزان ریسک( از 

تمهیدات لرزه ای برای سازه ای که در دسته  AISC341با بیشترین میزان می باشد. مطابق آئین نامه  Fاهمیت و خاک مناسب، ولی 

 یا کمتر باشد در نظر گرفته نمی شود. 9قرار دارند و همچنین ضریب رفتار نهایی آنها  Cتا  Aبندی لرزه ای 

  ضریب اهمیت ساختمان را در قسمتImportant Factor  و در قسمت  1.0برابرSystem Cd  0.7مقدارR  را وارد نمایید. این

رل دوران تیر پیوند استفاده می شوند. برای محاسبه دوران تیر انتخاب نمایید و برای محاسبه و کنت EBFاعداد تنها وقتی نوع قاب را 

تغییرمکان غیرخطی از ضرب  ASCE/SEI 7پیوند، از تغییرمکان جانبی واقعی )غیرخطی( سازه استفاده می شود. مطابق آئین نامه 

 ویرایش سوم ایران 2055مه ضریب تشدید تغییرمکان می باشد. در آئین نا dCبدست می آید که  IdC/تغییرمکان خطی در ضریب 

است.  بصورت جدولی ارائه dCبود که در ویرایش چهارم ضریب  معرفی شده 0.7Rبرای تبدیل تغییرمکان خطی به غیرخطی ضریب 

 بنابراین برای اینکه تناظر بین دو آئین نامه درست صورت گیرد، اعداد ذکر شده برای این دو قسمت وارد نمایید.
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  در قسمتSystem Rho  را بر اساس ضریب   1.2یا  1.0عددρ   .در قسمت وارد کنیدSystem Sds  را وارد نمایید ) 0عددSds 

در صورتی که سیستم باربر لرزه ای در یک  2055ایران یکی است(. در آئین نامه  2055در آئین نامه  A(1+S)در آئین نامه آمریکا با 

افزایش  %25می باشد ضرب می شود )نیروی زلزله  1.2که  ρزلزله آن راستا در عدد راستا به میزان مناسبی مهیا نشده باشد، نیروی 

در نظر گرفته  1.0ایران تا قبل از ویرایش چهارم این ضریب وجود نداشت. به عبارت دیگر این ضریب  2055می یابد(. در آئین نامه 

معرفی شده است. علاوه بر این در آئین نامه  1.2میزان  به ρویرایش چهارم ضریب  2055شده بود. هرچند در پیش نویس آئین نامه 

ASCE/SEI 7  برای در نظر گرفتن اثر مؤلفه قائم زلزله، تمام بارهای مرده به اندازهDS0.2S  افزایش یا کاهش داده می شود. در آئین

می  0ارت دیگر این ضریب برابر ویرایش سوم و پیش نویس چهارم این آئین نامه، چنین روشی دیده نشده است. به عب 2055نامه 

باشد. دقت کنید که در آئین نامه آمریکا این افزایش بار مرده بخاطر اثر زلزله قائم هم در ترکیبات بار عادی و هم در ترکیبات بار 

ر تشدید یافته اتشدید یافته، یک بار به صورت افزایشی و یکبار بصورت کاهشی می بایست اعمال گردد. بنابراین بطور مثال ترکیبات ب

 به قرار زیر است: ASCE/SEI 7مطابق آئین نامه 

 

را در ساخت ترکیبات بار پیش فرض معمولی و تشدید یافته خود استفاده می نماید. این برنامه این ضریب را برای  ρضریب  ETABSبرنامه 

 هر دو راستای ساختمان فقط یک عدد در نظر می گیرد.

  همانطور که مشاهده کردید در برنامهETABS 9.7.4  دو بار و در دو قسمت مختلف یکی در منویDefine > Special Seismic 

Load Effects  و دیگری در قسمتOptions > Preferences > Steel Frame Design  تنظیمات پارامترهای لرزه ای مثل

ρ  0وΩ   در را می پرسد. این ایراد برنامه است کهETABS 2013  برطرف شده است و تمامی تنظیمات مربوطه در یک قسمت

از عدد معرفی شده در منوی   0Ωو  Optionsاز عدد وارد شده در قسمت   ρنیز  ETABS 9.7.4تجمیع شده اند. هرچند در برنامه 

Define  قرائت می شود. برنامهETABS ستفاده کرده و برای هر دو راستای این ضریب را برای ساخت ترکیبات بار تشدید یافته ا

 ساختمان فقط یک عدد می تواند بگیرد.

  در قسمتDesign Provision  روش طراحی راLRFD  و بعدی آئین  2550انتخاب کنید. دقت نمایید که در ویرایش های سال

 ASDنیز برای طراحی وجود دارد. روش  (ASD)، روش مقاومت مجاز (LRFD)، علاوه بر روش ضرایب بار و مقاومت  AISC360نامه 

مقاومت  LRFDمعرفی شده در این آئین نامه بدین صورت است که ابتدا می بایست با استفاده از فرمول های ارائه شده برای حالت 

مت مقاوکاهش یابند تا به  φ ضریب کاهش مقاومتمحاسبه شوند. سپس به جای آنکه این مقاومت ها با  n(R(اعضاء  های اسمی

برسیم. بطور مثال برای محاسبه ظرفیت  n(R (Ω/مقاومت مجازتقسیم شده تا به   Ω ضریب اطمینانبرسیم، بر  φR)n( طراحی

ضرب کنیم تا به  φ=0.9را در عدد  n(T(حالت حدی تسلیم، بجای آنکه ظرفیت اسمی کششی عضو  کششی یک عضو تحت معیار

تقسیم می کنیم تا به مقاومت  Ω=1.67، مقاومت اسمی بدست آمده را بر عدد n= 0.9 Tn(φ T(مقاومت طراحی کششی عضو برسیم 

. هر چند مقاومت مجاز با نیروهای بدست آمده از ترکیبات بار تقریباً بدون ضریب مقایسه n/Ω = 0.6 Tn(T(مجاز کششی عضو برسیم 

می شود. اما مقاومت طراحی را می بایست با نیروهای بدست آمده از ترکیبات بار نهایی مقایسه نمود. در حقیقت می توان گفت که 
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یی دارند. ولی پایه محاسبات همان روش حدی می باشد. در این روش یک حقّه برای کسانی است که فقط با روش تنش مجاز آشنا

روش  ETABSارائه شده است. در هر صورت در این قسمت از برنامه  LRFDآئین نامه مبحث دهم مقررات ملی ایران نیز تنها روش 

LRFD .را انتخاب نمایید 

  در قسمتDesign Analysis Method  نوع تحلیل و طراحی برای پایداری راDirect Analysis  انتخاب نمایید. تا قبل از آئین

صورت می گرفت. در این روش  (Effective Length Method)طرح پایداری سازه فقط با روش طول مؤثر  AISC360-05نامه 

ی دبرای دیدن اثرات سیستم بر مقاومت یک عضو از ضریب طول مؤثر درهنگام طراحی استفاده می شد. این روش که با فرضیات متعد

 Directروش  AISC360-05همراه بود، روش مناسبی برای طرح پایداری همه سازه ها نبود. به همین دلیل در در آئین نامه 

Analysis  به عنوان یک راهکرد جدید در پیوست این آئین نامه آورده شد. در آئین نامهAISC360-10  روشEffective Length 

به جای آن به متن اصلی آئین نامه  Direct Analysisپیوست آئین نامه منتقل شد و روش که دارای محدودیت هایی می باشد، به 

در محاسبات مقاومت ستون در نظر گرفته می شود  1.0برابر  (K)ضریب طول مؤثر ستونها  Direct Analysisافزوده شد. در روش 

است. ولی  0.8های محوری، برشی و پیچشی برابر اما سختی اعضاء در تحلیل و طراحی کاهش داده می شود. ضریب کاهش سختی 

ضریبی است که وابسته به نیروی محوری اعضاء می باشد و   bτمی باشد. در این رابطه  b0.8 τضریب کاهش سختی خمشی برابر 

ده ائه شهرچه نیروی محوری عضو بیشتر باشد، این ضریب کمتر است. دقت کنید که کاهش سختی اعضاء در طراحی در فرمولهای ار

 توسط آئین نامه لحاظ شده است و نیازی به لحاظ کردن مجدد توسط ما نیست. 

باشد، امکان  1st/ Δ  2ndΔ   1.5 ≥نیز مطابق آئین نامه به شرط آنکه نسبت  Effective Lengthدر هر صورت استفاده از روش 

پذیر است. شرط اخیر در اکثر سازه هایی که بطور مناسبی طراحی شده باشند، برقرار است. برای قابهای مهارشده تفاوت زیادی بین 

 Effectiveوجود ندارد. دراین نوع قابها در صورتی که روش  Effective Lengthو  Direct Analysisاستفاده از دو روش 

Length ییم، ضریب را انتخاب نماEffective Length Factor (Minor , Major)  ستونها در قسمتOverwrite را بایستی

لحاظ کنیم. هر چند برای قابهای خمشی این دو روش می توانند تفاوت بسیار زیادی نسبت به هم داشته باشند. برای حالت  1.0

 استفاده شود. Direct Analysisاخیر توصیه می شود حتماً از روش 

  روش هنگامی کهDirect Analysis  را در برنامهETABS  برای تحلیل و طراحی پایداری سازه انتخاب می کنیم، خود برنامه بصورت

 نمود. Assignداخلی ضرایب کاهش سختی را اعمال می کند و نیازی به این نیست که بصورت دستی کاهش سختی ها را 

  در قسمتStiffness Reduction Method  گزینهTau-b Variable  را انتخاب نمایید. همانطور که گفته شد، هنگامی که از

ضرب می  0.8برای تحلیل و طراحی پایداری سازه استفاده می شود، سختی های اعضاء در ضرایب کاهش  Direct Analysisروش 

یر بوده و وابسته به نیروی که متغ 1.0ضریبی است کوچکتر از  bτضرب می شود.  b0.8τشوند، بجز سختی خمشی که در ضریب 

گرفت(، به شرط آنکه بار  1.0برابر را  bτ را ثابت فرض کرده )محوری عضو می باشد. هر چند می توان مطابق آئین نامه این ضریب 

ه بر افدر تمامی ترکیبات بارگذاری، حتی ترکیبات بارگذاری شامل بار جانبی، افزود. این بار فرضی، اض Y 0.001فرضی ای به اندازه 

برای است که بطور معمول تنها در ترکیبات بارگذاری ثقلی اعمال می گردد.  Y 0.002بار فرضی مربوط به ناشاقولی ستونها به اندازه 

هر دو گزینه  ETABSرا متغیر در نظر بگیریم. هر چند  bτآنکه دچار دردسرهای مربوط به این قضایا نشویم، بهتر است همیشه ضریب 

Tau-b Fixed  وTau-b Variable .را دارا می باشد 

  نکته ای که وجود دارد آن است که تا قبل از آنکه اولین طراحی بر اساس آئین نامهAISC360-05/IBC2006  با استفاده از روش

Direct Analysis  انجام شود، سختی های اعضاء سازه کاهش نیافته باقی خواهند ماند. اما پس از آن در صورت تحلیل دوباره سازه

)بدون تغییر نوع آئین نامه(، ضرایب کاهش سختی اعمال می شوند و بنابراین از آن پس است که می توان بطور مثال مشاهده نمود 

ر کاهش سختی افزایش یافته اند. برنامه پس از اولین طراحی بر اساس این آئین نامه با که تغییرمکان جانبی سازه و خیز تیرها بخاط



 

 

 معاونت معماری و شهرسازی شهرداری شیراز

 مدیریــت کنتــرل و نظــارت ساختمــان
 

 11 از 14 صفحه

 

49-1 50-2راهنمای شماره   

 ETABSنکات طراحی به روش حالت های حدی در 

 

پیامی را نمایش می دهد که حداکثر میزان تغییر سختی اعضاء و تعداد اعضایی که سختی آنها تغییر داشته  Direct Analysisروش 

برای کاهش سختی استفاده شده است و  Tau-b Fixed( حالتی را نشان می دهد که از روش 12است را نشان می دهد. شکل )

تغییر یافته  0.8به عدد  1.0می باشد )ضریب تغییر سختی از عدد  0.2بنابراین تغییر ضریب کاهش سختی اعضاء حداکثر به اندازه 

ثر تغییر ضریب تغییر استفاده نموده ایم. در این حالت حداک Tau-b Variable( مثالی از سازه ای است که از روش 19است(. شکل )

 تغییر یافته است(. 0.61به حداکثر عدد  1.0بوده است )ضریب سختی خمشی از عدد  0.39سختی 

  ،مطابق آئین نامه برای کنترل های سازه در حالت حدی بهره برداری مانند کنترل دریفت، خیز تیر، محاسبه پریود و کنترل فرکانس

تبدیل کرده و  AISC-ASD89بنابراین برای مثلاً کنترل دریفت ابتدا آئین نامه را مثلاً به نیاز به اعمال کاهش سختی اعضاء نیست. 

کنید تا از نتیجه بدست آمده برای کنترل دریفت سازه استفاده نمایید. هرچند اگر سازه در مدلی که سختی  Runسپس مدل خود را 

نیز این کنترل جوابگو خواهد بود. نکته دیگر آنکه با توجه به تغییر  سازه را کاهش داده اید جوابگوی دریفت مجاز بود، در مدل اصلی

سختی سازه، پریودهای مودهای ارتعاشی بدست آمده نیز اعداد بیشتری بوده و نتایج تحلیل دینامیکی نیز تغییر می کند. راه حل آن 

( تحلیل نموده و سپس توزیع استاتیکی AISC-ASD89است که در مرحله آخر طراحی، یک مدل با سختی اصلی )تغییر آئین نامه به 

 نظیر تحلیل دینامیکی نیروها را قرائت و سپس بر سازه اعمال و بر اساس آن سازه را کنترل نماییم.

  

 

 (Tau-b Fixedپیام برنامه مبنی بر تغییر سختی اعضاء و نیاز به تحلیل مجدد سازه بر اساس سختی های جدید )روش  (12) شکل

 

 

 (Tau-b Variableبر تغییر سختی اعضاء و نیاز به تحلیل مجدد سازه بر اساس سختی های جدید )روش  پیام برنامه مبنی (19) شکل
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  در قسمتSecond Order Method  روشOrder stAmplified 1  را انتخاب کنید. بطور کلی دو روش برای در نظر گرفتن

در برنامه شناخته می شود، روش دقیق  Order ndeneral 2Gآثار مرتبه دوم نیروها در محاسبات وجود دارد. روش اول که به نام 

مستقیماً در هنگام تحلیل سازه دیده شود. روش دوم که روشی تقریبی و  (P-δو  P-Δ)اثرات  است. در این روش اثرات مرتبه دوم

شناخته می شود، بدین صورت است که سازه را تحلیل مرتبه  Order stAmplified 1دارای محدودیت است در برنامه به نام روش 

 B1تشدید می نماییم.  B2و  B1اول خطی کرده و در هنگام طراحی اعضای سازه، نیروهای بدست آمده از این تحلیل را با ضرایب 

بارهای با حرکت جانبی ضریب تشدید مربوط به  B2ضریب تشدید مربوط به بارهای بدون حرکت جانبی )معمولاً بارهای ثقلی( و 

در نظر  1.0می باشد را برابر  P-Δکه مربوطه به اثر  B2همواه ضریب  ETABS)معمولاً بارهای جانبی مثل زلزله( می باشد. برنامه 

 ETABSدر هنگام تحلیل سازه فعال شده است. نکته دیگر آنکه برنامه  P-Δمی گیرد. به عبارت دیگر همیشه فرض می کند تحلیل 

)اثرات مرتبه دوم مربوط به  P-δ)اثرات مرتبه دوم مربوط به بارهای با حرکت جانبی( را انجام داده ولی تحلیل  P-Δحلیل فقط ت

همواره در  بر این اساسرا محاسبه می نماید.  B1ضریب تشدید  می تواندبارهای بدون حرکت جانبی( را انجام نمی دهد. بنابراین 

بدین صورت  ETABSروال طراحی برنامه   را فعال نمود. P-Δه روش حدی، می بایست تحلیل هنگام تحلیل و طراحی یک سازه ب

در نظر می گیرد. اما در صورت  1را نیز محاسبه نکرده و برابر  B1ضریب  Order ndGeneral 2در صورت انتخاب گزینه است که 

 1.0را برابر  B2مقدار می کند. همانطور که گفته شد برنامه همواره محاسبه را  B1، مقدار Order stAmplified 1 انتخاب گزینه

کردن هستند.  Overwriteقابل  B2و  B1انتخاب شود، مقادیر  Order stAmplified 1اگر روش همچنین در نظر می گیرد. 

 سبه گردد.بطور صحیحی محا B1را انتخاب کنید تا مقدار  Order stAmplified 1گزینه بنابراین در این قسمت 

  مقادیر پیش فرض برنامه برای ضرایب کاهش مقاومتφ .را که مطابق آئین نامه می باشد، تغییر ندهید 

  در صورتی که بخواهید برنامه کنترل های لرزه ای مربوط به سیستم باربر جانبی را انجام دهد، در قسمتIgnore Seismic Code? 

را انتخاب نمایید. این بدان معناست که کنترل های طرح لرزه ای روی سازه صورت پذیرد. این کنترلها برای هر نوع قاب  Noگزینه 

مطابق آنچه در قسمتهای قبل ذکر گردید متفاوت می باشد. اما برای همه انواع قابها طرح لرزه ای شامل کنترل فشردگی مقاطع )بجز 

 ری ستون تحت ترکیبات بار تشدید یافته وجود دارد.( و محاسبه نیروی محوOMFسیستم 

  در صورتی که در قسمت قبل گزینهNo  را انتخاب کرده باشید و بخواهید برنامه ترکیبات بار تشدید یافته را بطور اتوماتیک ساخته و

تخاب بدان مفهوم است که را انتخاب کنید. این ان Noگزینه  ?Ignore Special Seismic Loadبر سازه اعمال نماید، در قسمت 

انتخاب کنیم، تفاوتی نمی کند در این  Yesستونها تحت اثر ترکیبات بار تشدید یافته کنترل شوند. درصورتی که در قسمت قبل 

قسمت چه گزینه ای را انتخاب نماییم. در صورتی که بخواهید خودتان ستونها را برای ترکیبات بار ویژه کنترل نمایید، هر دو گزینه 

Ignore Seismic Code?  وIgnore Special Seismic Load?  راYES .انتخاب کنید 

بنابراین اگر نخواهیم برنامه ستونها را ترکیبات بار تشدید یافته ای که خود بصورت اتوماتیک می سازد کنترل نماید، کافی است : نکته

 را انتخاب نماییم. Yesگزینه  ?Ignore Special Seismic Loadو یا  ?Ignore Seismic Codeدر یکی از دو قسمت 

را  …Do Not Includeو یا  …Includeگزینه  Special Seismic Load EffectsDefine<در قسمت : مستقل از آنکه نکته

( Options>Preferences>Steel Frame Defineانتخاب نمایید، برای برنامه ملاک آن چیزی است که در این قسمت )منوی 

این کنترل ها را فعال  Defineانتخاب می نمایید. بدین معنی که اگر در این قسمت کنترل های لرزه ای را فعال کنید، چه در منوی 

و چه غیرفعال کرده باشید، کنترل لرزه ای انجام خواهد پذیرفت. وبرعکس اگر در این قسمت کنترل های لرزه ای را غیرفعال کرده 

چه چیزی انتخاب شده باشد، این کنترل ها صورت نمی پذیرد. تنها در صورتی که منوی  Defineدر منوی  باشید، مستقل از آنکه

Define 0را فعال کنید، برنامه مقدارΩ  را از این قسمت قرائت کرده و نسبت به آنچه در منویOptions  وارد نموده اید، برتری

 خواهد داد.
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  در قسمتIs Doubler Plate Plug Welded?  مشخص نمایید که در صورتی که نوع قاب راIMF  یاSMF  ،انتخاب کرده اید

شکل جوش انگشتانه می دهید یا خیر. درصورتی که ورق مضاعف به جان ستون جوش انگشتانه  Hورق مضاعف را به جان ستون 

یداری ورق جان ستون در نظر ن مجموع ضخامت جان ستون و ورق مضاعف را برای کنترل ضابطه پاشود، مطابق آئین نامه می توا

 گرفت.

  دو گزینهHSS Welding Type  وReduce HSS Thickness?  به این خاطر است که مطابق آئین نامهAISC360-05  و مبحث

 0.93باشد،  ERW (Electric-Resistant-Welding)دهم ایران برای مقاطع توخالی )باکس و لوله( در صورتی که نوع جوشکاری 

 برشی مقطع در نظر گرفته می شود.  روفیل در محاسباتضخامت ورق پ

  گزینهConsider Deflection?  و تنظیمات بعدی برای کنترل خیز تیرها برای حالت حدی بهره برداری و دقیقاً مانند آنچه در

 روش تنش مجاز داشتیم می باشد.

  گزینهPattern Live Load Factor بارگذاری زنده روی تیر متصل به یک کنسول   برای در نظر گرفتن نامساعدترین وضعیت

وقتی کنسول و تیر مجاور بصورت صلب به ستون متصل شوند استفاده می شود. در این حالت برنامه لنگر ناشی از بارهای مرده روی 

ه است را و سر سادتیر کنارکنسول را محاسبه کرده و سپس لنگر ناشی از درصدی بار زنده روی تیر کنار کنسول با فرض اینکه تیر د

نیز محاسبه می نماید. حال جمع لنگر بارهای مرده و زنده را برای تیر کنار کنسول محاسبه نموده و با هم جمع می نماید. بین این 

 0د اگر عد وضعیت و وضعیتی که کل بار مرده و زنده روی تیر می باشد، آنکه لنگر بیشتری را حاصل کند معیار طراحی خواهد بود.

 را در این قسمت وارد نمایید به معنی عدم در نظر گرفتن این وضعیت می باشد.

  گزینه هایStress Ratio Limit  وMaximum Auto Iteration  را به ترتیب حد نسبت نیرو به مقاومت مجاز و همچنین

 د.تعداد تکراهای تحلیل و طراحی که بصورت اتوماتیک توسط برنامه اعمال می شود وارد نمایی

 

شده و هم ترکیبات بار  Design > Steel Frame Design > Select Design Comboپس از انجام تنظمیات طراحی، وارد قسمت  -15

Strength  و هم ترکیبات بارDeflection  پیش فرض برنامه را بیرون بریزید. سپس ترکیبات باری که قبلاً برای طراحی تعریف کرده اید را

ترکیبات بار پیش فرض آئین نامه را به ترکیبات بار انتخاب شده ،  Runپس از هر بار  ETABS 9.7.4ی دقت کرد برنامه انتخاب نمایید. بایست

 ETABS 2013این عیب در  قسمت، در هنگام طراحی می افزاید و باید دوباره عمل مزبور را قبل از طراحی سازه انتخاب نمایید. البته در این

 برطرف شده است.

 Kانتخاب کرده اید، برای ستونها لازم نیست هیچ مقداری را برای  Direct Analysisبه اینکه نوع تحلیل و طراحی برای پایداری را با توجه  -11

 را اصلاً قرائت نمی کند. K)ضریب طول مؤثر( معرفی نمایید. چون در این حالت برنامه مقادیر معرفی شده برای 

 Design > Steel Frame Design > View/Reviseده اند انتخاب کرده و با استفاده از گزینه تمامی تیرهایی که در داخل سقف مدفون ش -12

Overwrite پیچشی را در قسمت  -مقدار طول مهار نشده برای کنترل معیار کمانش جانبیUnbraced Length Ratio (LTB)  مانند شکل

را انجام می دهد. برای آنکه این کنترل برای  KL/r≤200و خمشی، کنترل ( یک عدد کوچک وارد کنید. برنامه برای تمامی اعضاء فشاری 14)

را نیز در این قسمت عددی  Unbraced Length Ratio (Minor)و  Unbraced Length Ratio (Major)تیر صورت نگیرد، دو ضریب 

و سپس محاسبه ظرفیت فشاری ستونها  KL/rمحاسبه از اعداد وارد شده در این دو قسمت اخیر فقط برای  ETABSکم وارد نمایید. کلاً برنامه 

 استفاده می نماید.

را برای این تیرها انجام ندهد، دو ضریب  KL/r≤200تیرهایی که در داخل سقف مدفون نیستند را انتخاب نموده و برای آنکه برنامه کنترل  -19

Unbraced Length Ratio (Major)  وUnbraced Length Ratio (Major) ( (.10را اعداد کمی وارد نمایید )شکل) 
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 Unbraced Length)مهاربندهای نوع ضربدری را انتخاب کرده و دستور قسمت قبل را اجراء کنید. حال در این قسمت نسبت طول مهار نشده  -14

Ratio)  را حول محورهای اصلی و فرعی(Major – Minor)  ارد نمایید. دوباره یادآوری ( و11مطابق شکل ) 0.7و  0.5به ترتیب برابر اعداد

برنامه مقادیر ضریب طول مؤثر حول دو محور را قرائت نمی کند و هر اعدادی در  Direct Analysisمی شود که با توجه به استفاده از روش 

 معرفی کنیم بدون استفاده است. Effective Length Factor (K Minor)و  Effective Length Factor (K Major)قسمت 

 

وارد کردن نسبت فاصله مهارجانبی بال فشاری تیرهای مدفون در سقف، همچنین ضرایب طول تیر حول دو محور برای خنثی  (14) شکل

 برای این اعضاء KL/r≤200کردن کنترل 
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وارد کردن نسبت فاصله مهارجانبی بال فشاری تیرهای مدفون در سقف، همچنین ضرایب طول تیر حول دو محور برای خنثی  (10) شکل

 برای این اعضاء KL/r≤200کردن کنترل 
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 وارد کردن نسبت فاصله طول مهارنشده مهاربندهای ضربدری حول محورهای اصلی و فرعی (11) شکل
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 :به موارد زیر دقت نمایید Design > Steel Frame Design > View/Revise Overwriteدر قسمت  -10

  در برنامهETABS  با آنکه در قسمتOptions > Preferences > Steel Frame Design  نوع سیستم لرزه بر را می توان برای

 Frameکرد. گزینه  Overwriteکل سیستم مشخص نمود، برای هر عضو نیز می توان بطور جداگانه سیستم لرزه بر دیگری را 

Type .در این قسمت بدین منظور است  

  گزینه هایUnbraced Length Ratio (Major , Minor)  تنها برای محاسبه ظرفیت اسمی فشاری)n(P  اعضاء بر اساس معیار

حول محورهای کمانش خمشی توسط برنامه استفاده می شود و در محاسبه ظرفیت تیرها بی تأثیر است. این ضرایب در طول عضو 

 بر را ضرایب اصلی و فرعی ضرب شده و برای محاسبه لاغری ستون حول دو محور استفاده می شود. برنامه بطور پیش فرض این

این ضرایب در فرم خلاصه محاسبات طراحی عضو  .نماید می محاسبه تحتانی و فوقانی گاه تکیه یا تیر بین ستون خالص طول اساس

 می شود.معرفی  L Factorبا نام 

  گزینهUnbraced Length Ratio (LTB)  در طول عضو ضرب شده و در تیرها برای محاسبه ظرفیت خمشی تیر بر اساس معیار

 بر اساس معیار کمانش پیچشی استفاده می شود. n(P(پیچشی و در ستونها برای محاسبه ظرفیت اسمی فشاری  -کمانش جانبی

این ضریب کاربرد ندارد. زیرا معیار کمانش پیچشی حاکم بر طرح ستون نبوده  BOXمثل  برای ستونهای با مقاطع جدار نازک بسته

در نظرمی  Unbraced Length Ratio (Minor)برنامه بطور پیش فرض این ضریب را برابر و توسط برنامه محاسبه نمی شود.

 معرفی می شود. Lltbاین ضریب در فرم خلاصه محاسبات طراحی عضو با نام  گیرد.

  ضرایبEffective Length Factor (K Major , K Minor)  فقط وقتی که از روشEffective Length  استفاده شود کاربرد

باشد توسط برنامه قرائت نمی شود. این ضریب در فرم خلاصه محاسبات طراحی عضو  Direct Analysisرد. و اگر روش انتخابی اد

ل مهار نشده ستون ضرب شده و پس از محاسبه لاغری عضو از آن برای محاسبه ظرفیت معرفی می شود. این ضرایب در طو K2با نام 

 فشاری ستون بر اساس معیار کمانش خمشی و با استفاده از فرمول زیر استفاده می شود:
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 فرمولهای محاسبه ظرفیت اسمی فشاری عضو بر اساس معیار کمانش خمشی (17) شکل

 

  مقادیرEffective Length Factor (K Major Braced , K Minor Braced)  که در خروجی های محاسبات برنامه به نام

K1  معرفی می گردد، در محاسبه ضریب تشدید بارهای بدون حرکت جانبی یعنیB1  .استفاده می شوندETABS  بطور محافظه

که قبلاً گفته شد برنامه ضریب همانطور  شود. Overwriteدر نظر می گیرد مگر آنکه توسط کاربر  1.0کارانه این ضریب را برابر 

B2  در نظر می گیرد. اما ضریب  1.0را محاسبه نکرده و همواره برابرB1  را محاسبه می نماید. فرمول محاسبهB1 :به قرار زیر است 

 

 

 

 

 

 

 

 B1فرمولهای محاسبه ضریب  (10) شکل
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  ضریبEffective Length Factor (K LTB)  ضریبی طول مؤثر پیچشی است که پس از ضرب در طول مهارنشده پیچشی ستون

این  ETABS برنامهو بر اساس لاغری بدست آمده، ظرفیت نظیر اسمی فشاری بر اساس معیار کمانش پیچشی محاسبه می شود. 

 Effective Length Factor (Kبطور پیش فرض برابرمعرفی می کند،  Kltbکه در فرم های خلاصه محاسبات بنام را  ضریب

Minor) ،آنکه مقدار دیگری مگر در نظر می گیرد Overwrite  .برنامه شودETABS  برای مقاطع غیر تنهاSD  یا غیرGeneral 

برای مقاطع با دو . ظرفیت فشاری بر اساس معیار کمانش پیچشی را محاسبه می نمایدلوله و قوطی(  و غیر جدارنازک بسته )غیر

( 17بر اساس فرمول زیر محاسبه شده و سپس با استفاده از فرمولهای شکل ) eFشکل( بطور مثال ایتدا  Hمحور تقارن )مثل ستون 

 ظرفیت فشاری بر اساس معیار کمانش پیچشی بدست می آید. E3-3تا  E3-1از 

 

 مقاطع با دو محور تقارن عضو فشاری بر اساس معیار کمانش پیچشی برای eFفرمول محاسبه  (19) شکل

 

  ضریبCb  یا ضریب لنگر یکنواخت، برای محاسبه ظرفیت اسمی خمشی تیرهایی که فاصله مهار جانبی بال فشاری آنها از مقدارLp 

معرفی شده در آئین نامه بیشتر است، استفاده می شود. این ضریب توسط برنامه محاسبه می شود مگر آنکه در این قسمت مقدار 

 شود. Overwriteدیگری برای آن 

 ضرایبMoment Coefficient (Cm Major , Cm Minor)    همان ضرایبCm  حول دو محور مقطع هستند که در محاسبه

 ( آورده شده است.10در شکل ) Cmمحور استفاده می شوند. فرمولهای محاسبه ضریب حول دو  B1ضرایب 

  در قسمتNonSway Moment Factor (B1 Major , B1 Minor)  می توان ضرایبB1  را حول دو محور عضوOverwrite 

محور عضو را حول دو  B2می توان ضرایب  Sway Moment Factor (B2 Major , B2 Minor)کرد. همچنین در قسمت 

مقادیر  ETABSبرای در نظر گرفتن آثار مرتبه دوم استفاده نمایید، برنامه  Order stAmplified 1تغییر داد. تنها وقتی از روش 

Overwrite  شده برایB1  وB2 .را قرائت می کند 

  در قسمتOverstrength factor, Ry  مورد انتظار به تنش تسلیم می توانید مقدار اضافه مقاومت مصالح )نسبت تنش تسلیم

و برای مقاطع  2/1، برای مقاطع نورد شده  20/1حداقل مصالح( را معرفی کنید. این ضریب برای مقاطع نورد شده لوله و قوطی 

ظرفیت اتصال تیر به ستون یا  ETABSمی باشد. در برخی از انواع سیستم های لرزه ای، برنامه  10/1ساخته شده از ورق برابر 

 مورد استفاده قرار می گیرد. Ryندی را نیز ارائه می دهد. در این خروجی ها ممکن است ضریب مهارب

  برنامهETABS  مقادیر ظرفیت اسمی فشاری(Pnc) کششی ،(Pnt) 3و2، خمشی حول محورهای (Mn3 , Mn2)  برشی در ،

 کند. Overwriteرا محاسبه می نماید. اما کاربر می تواند این مقادیر را  (Vn2,Vn3) 3و2راستای محورهای 
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 Design > Steel Frameها، می توان با اجرای دستور  Overwriteپس از انجام تنظیمات طراحی، انتخاب ترکیبات بار طرح و مقادیر  -11

Design > Start Design/Check of Structure .به طراحی سازه پرداخت 

با کلیک راست روی هر عضو طراحی شده می توان ریز محاسبات مربوط به هر عضو را مشاهده نمود. بطور مثال با کلیلک راست روی یک ستون  -17

 : پنچره ای مانند شکل زیر ظاهر می شود Detailsکنار مهاربند و انتخاب دکمه 

 

 LRFDجزئیات طراحی یک ستون به روش (25) شکل

 

 پنجره تنظیمات آئین نامه ای، مشخصات عضو، مشخصات پروفیل نمایش داده شود در سطرهای ابتدایی این ملاحظه می  همانطورکه

نسبت نیرو به ظرفیت عضو نمایش داده شده است که جمع ناشی از مقادیر مربوط به نیروی  D/C Ratioشده است. در قسمت 

شود برای ستون انتخابی با توجه به آنکه ترکیبات بار تشدید محوری و لنگرهای خمشی حول دو محور است. همانطور که ملاحظه می 

یافته حاکم شده اند، فقط نسبت نیرو به ظرفیت مربوط به نیروی محوری مقدار دارد و مقادیر نظیر مربوط به لنگرهای خمشی صفر 

شود نیز همانطور که مشاهده می  STRESS CHECK FORCES & MOMENTS (Combo COMB….)هستند. در قسمت 
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فرمولی ارائه شده است که مربوط به کنترل ستون برای ترکیبات بار تشدید یافته می باشد باز هم نشان دهنده آن است که در طرح 

 این ستون ترکیبات بار تشدید یافته حاکم شده اند.

  در قسمت بعدی مقادیرL ،K1 ،K2 ،B1 ،B2  وCm  را که کاربر معرفی کرده و یا توسط برنامه محاسبه و در نظر گرفته شده اند

 وارد شده یا محاسبه شده ارائه گردیده اند. Cbو  Lltb  ،Kltbنمایش داده می شود. همچنین در خط بعدی مقادیر 

  در قسمت بعد نیروی محوری نهایی ستون(Pu)  در ترکیب بار حاکم، ظرفیت فشاری طراحی(phi*Pnc)  ظرفیت کششی طراحی و

(phi*Pnt)  ارائه گردیده است. ظرفیت کششی طراحی بر اساس کمترین مقدار بدست آمده از دو معیار تسلیم و گسیختگی محاسبه

می گردد. ظرفیت فشاری طراحی نیز حداقل مربوط به دو معیار کمانش خمشی و کمانش پیچشی )در صورتی که برای پروفیل 

و لوله( و همچنین  Boxکنترل شده باشد( می باشد. همانطور که گفته شد برنامه برای پروفیلهای جدارنازک بسته )مربوطه این معیار 

معیار کمانش پیچشی را برای محاسبه ظرفیت فشاری عضو در نظر نمی گیرد. برای آنکه بدانیم آیا برنامه  Generalیا  SDمقاطع 

که در محاسبات این معیار استفاده می شود در فرم  Cwگرفته است یا خیر به پارامتر  این معیار را در محاسبه ظرفیت ستون در نظر

جزئیات محاسبات دقت کنید. اگر این پارامتر نشان داده شده باشد، نشان از آن است که این معیار برای پروفیل مورد نظر توسط 

 برنامه در نظر گرفته شده است.

 

 کمانش پیچشی در محاسبه ظرفیت فشاری عضوو در نظر گرفتن معیار  Cwپارامتر  (21) شکل
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  در قسمت بعدی مقادیر لنگر خمشی نهایی عضو در ترکیب بار مورد بررسیMu  ظرفیت خمشی طراحی عضو با در نظر گرفتن ،

و ظرفیت خمشی طراحی عضو بدون در نظر  phi*Mnپیچشی(  -معیارهای تسلیم، کمانش موضعی و کمانش کلی )کمانش جانبی

ارائه شده است. به عبارت دیگر در آخری ظرفیت خمشی طراحی عضو فقط با در نظر  phi*Mn No LTBیار کمانش کلی گرفتن مع

را نشان می دهد. برای  phi * ZFyگرفتن معیارهای تسلیم و کمانش موضعی است که اگر پروفیلی فشرده باشد، این عدد مقدار 

ارائه می شود، بدون آنکه هیچ کدام از سه معیار مربوطه کنترل  phi*SFyدر این دو قسمت فقط مقدار  Generalیا  SDمقاطع 

 شوند.

 در ترکیب بار انتخاب شده  جعبه ای )باکس( و لوله ایطع ادر قسمت بعد مقادیر لنگر پیچشی نهایی مقTu ظرفیت پیچشی اسمی ،

Tn  و ظرفیت پیچشی طراحیphi*Tn  ارائه شده است. بر خلاف طراحی بر اساس آئین نامهAISC-ASD89  که برنامه محاسبات

در مقاطع در برنامه استفاده کنید، کنترل برای پیچش نیز  AISC360-05اعضاء برای پیچش را انجام نمی داد، وقتی از آئین نامه 

 صورت می گیرد.ذکر شده 

  ترکیب بار مورد نظر در قسمت آخر نیز نیروی برشی نهایی مقطع درVu  در راستای هر دو محور پروفیل و همچنین مقدار ظرفیت

 ارائه گردیده است. Stress Ratioو نسبت نیرو به ظرفیت برشی  phi*Vnطراحی برشی تیر 

 

می بایست برای ترکیب بارهای ثقلی و ترکیب بار شامل نیروی نامتعادل طرح شوند. بنابراین می بایست  0و  7تیرهای متصل به مهاربندهای  -10

شود محاسبه نماییم. توصیه می دوباره مدل دیگری ذخیره کرده و با حذف مهاربندهای شورون و اعمال نیروهای نامتعادل، تیرهای مربوطه را 

 0و  7متوالی با مقطع پروفیل یکسان استفاده گردد. همچنین لاغری مهاربندهای  0و  7نباشد از مهاربندهای  که نیاز با این محاسباتبرای آن

بایست می نیز  این کنترل انتخاب کرده باشید، OMFکه در صورتی که نوع سیستم لرزه بر را  بیشتر شود 110نباید از عدد مطابق آئین نامه نیز 

 .دستی صورت پذیردبصورت 

 

 نکته تکمیلیچند 

با  Pro.*بسازید و یا از پروفیهای تعریف شده در فایلهای  SDدر برنامه  ETABSهمانطور که گفته شد، در صورتی که مقاطع تیرها را در  (1

و کمانش کلی  بدون آنکه بر اساس سه معیار حالت حدی تسلیم، کمانش موضعی ETABSاستفاده کنید، برنامه  Generalمقاطع نوع 

در نظر می گیرد. به نکات زیر  SFyپیچشی( مقاومت اسمی خمشی تیر را محاسبه نماید، مقاومت خمشی اسمی را برابر  -)کمانش جانبی

 در این باره توجه نمایید:

  در صورتی که تیر تعریف شده در برنامهSD  پروفیلI  نورد شده با ورق تقویتی و جوش غیرپیوسته باشد، به شرط آنکه تیر در داخل

سقف مدفون شده باشد، فرض در نظر گرفته شده توسط برنامه برای مقاومت خمشی می تواند معقول باشد. دقت کنید که در روش 

، به شرط آنکه مهارجانبی مناسب pf≤λf(λ(در صورتی که لاغری موضعی بال طوری باشد که تیر فشرده حساب شود  LRFDطراحی 

خواهد بود. اگر در همین تیر نسبت لاغری موضعی  ZFy، مقاومت اسمی خمشی برابر p≤Lb(L(برای بال فشاری وجود داشته باشد 

خواهد بود. در صورتی که  SFy 0.7مقاومت اسمی خمشی برابر   fr=λf(λ( بال طوری باشد که دقیقاً تیر غیر فشرده محسوب شود

بصورت خطی تغییر  SFy 0.7و  ZFyمقاومت اسمی خمشی بین دو مقدار  fr≤λ f≤ λfp(λ(لاغری موضعی بال بین این دو  مرز باشد 

خواهد کرد. این مطلب بر خلاف آن چیزی است که در روش تنش مجاز داشتیم. در روش تنش مجاز اگر پروفیلی فشرده بود مقاومت 

 می بود و تغییر خطی مقاومت را نداشتیم. SFy 0.6ر این مرز را رد می کرد می شد و اگ SFy 0.66خمشی مجاز آن 
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  در صورتی که تیر تعریف شده در برنامهSD  پروفیلI  نورد شده با ورق تقویتی و جوش پیوسته باشد، به شرط آنکه تیر در داخل

در نظر گرفت.  ZFyکه فرض برنامه برای مقاومت اسمی خمشی این نوع مقاطع است،  SFyسقف مدفون باشد، می توان به جای 

معرفی نمود، طوری که مشخصات جان آن دقیقاً مانند مشخصات  I/Wide Flangeشکل در قسمت  Iبدین منظور می توان تیری 

تی باشد. عرض این تیر طوری تعیین می شود تیر اولیه بوده ولی ضخامت بال آن برابر مجموع ضخامت بال تیر نورد شده و ورق تقوی

شکل برابر مساحت بال تیر نورد شده بعلاوه ورق تقویتی باشد. بجای این روش می توان از روش تقریبی زیر   Iکه مساحت بال تیر

ی که در برنامه است، می توان برای پروفیلهای فشرده ا 1.2تا  1.1بین  Z/Sشکل نسبت  Iاستفاده کرد. از آنجا که در پروفیلهای 

SD  1.1تعریف می شوند، مصالح دیگری تعریف نمود که تنش تسلیم آن Fy .می باشد 

 می  پیچشی -در صورتی که تیری در داخل سقف مدفون نباشد، با توجه به آنکه مقاومت اسمی خمشی بر اساس معیار کمانش جانبی

تعریف شده  Iاستفاده کرد. بنابراین یا برای این تیرها از مقطع  SDبایست محاسبه گردد، نمی توان از مقطع ساخته شده در برنامه 

شکل با ورق  I( استفاده کنید و یا اگر می خواهید تیری I/Wide Flangeشده در قسمت  Importتوسط برنامه )تعریف شده یا 

 نمایید. شکل با بال مساحت معادل تعریف Iتقویتی تعریف نمایید، با روش ذکر شده در بند قبلی، تیری 

  در طراحی تیرهای کامپوزیت، همانطور که می دانید، برنامهETABS  تنها پروفیلهایI  را طراحی می کند. بنابراین  ناودانیشکل یا

شکل معادلی را که هم ارتفاع پروفیل لانه زنبوری بوده ولی بقیه  Iدر صورت استفاده از مقاطع لانه زنبوری، می بایست مقاطع 

شکل معادل سازی  Iآماده ای که این مقاطع را با مقاطع  Pro.*روفیل اصلی یکسان است، تعریف نمود. فایلهای مشخصات آن با پ

 Iبا فرض مقطع فشرده با این پروفیلهای  ETABSکرده اند موجود است. در استفاده از آنها بایستی به این نکته دقت کرد که برنامه 

می گیرد. با توجه  SFyبه جای حداکثر  ZFyمی خمشی تیر را قبل از گیرش بتن برابر شکل جدید برخورد کرده و مثلاً مقاومت اس

(، می توان برای پروفیلهای لانه زنبوری معادل 1.1تا  1.0است )بین  1.1کمتر از  Z/Sبه آنکه در پروفیلهای لانه زنبوری نسبت 

 باشد. Fy/1.1م آن شکل، مصالح فولادی ای تعریف کرد که تنش تسلی Iسازی شده با پروفیل 

 

می تواند نیروی محوری ستونها را تحت اثر ترکیبات بار تشدید یافته کنترل کند. می توان بجای  ETABSهمانطور که در قبل گفته شد  (2

 این روش، کنترل لرزه ای برنامه را غیرفعال کرده و بصورت دستی این کار را انجام دهیم. بدین منظور کافی است ابتدا ترکیبات بار تشدید

مربوط به ترکیبات بارگذاری معاونت شهرسازی و معماری  99-152-1ستورالعمل شماره ضمیمه د ETABSیافته را ایجاد کرده )در فایل 

 Design > Steel Frameشهرداری شیراز، این ترکیبات بار قرار داده شده اند.( و سپس به قرار زیر آنها را اعمال کنید. ابتدا در قسمت 

Design > Select Design Combo نتخاب کنید. سپس تمامی ستونها را انتخاب نموده و در قسمت ترکیبات بار تشدید یافته را ا

Design > Steel Frame Design > View/Revise Overwrites  ظرفیت اسمی خمشی ستونها را حول هر دو محور(Mn3 , 

Mn2) افته ات بار تشدید یعددی بزرگ مانند شکل زیر وارد کنید. سپس دکمه طراحی سازه فولادی را کلیک کرده تا ستونها برای ترکیب

کنترل و طراحی گردیده و نسبت های نیرو به ظرفیت اعضاء نمایش داده شود. نیاز به کنترل دستی ستونها تحت ترکیبات بار تشدید یافته 

 می تواند به دلایل زیر صورت گیرد:

  مطابق آئین نامهAISC360-05  در صورتی که نسبتPu/φPn  کنترل ستون تحت ترکیبات بار کمتر باشد، نیاز به  0.4ستون از

حذف شده است. به عبارت دیگر کنترل ستونها برای زلزله تشدید یافته  AISC360-10تشدید یافته نیست. این شرط در آئین نامه 

 AISC360-05طراحی بر اساس آئین نامه  ETABS 9.7.4در تحت تمامی مقادیر نیروی محوری ستون می بایست صورت گیرد. 

می باشد. بنابراین  AISC360-10ترجمه  1992مطابقت داشت. مبحث دهم ویرایش  1907با مبحث دهم ویرایش  وجود دارد که

عمل کنیم می بایست بصورت دستی ترکیبات بار تشدید یافته را اثر دهیم. نکته  1992برای آنکه بطور کامل مطابق مبحث دهم 

مربوط  MANUALنیز افزوده شده است، اما اگر در  AISC360-10گزینه طراحی بر اساس  ETABS 2013دیگر آنکه هرچند در 
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همانی است  AISC360-10به روال طراحی بر اساس این آئین نامه در نرم افزار بنگریم، متوجه می شویم که موتور طراحی بر اساس 

مورد از ایردات برنامه می باشد  بوده است و روال طراحی مزبور هیچ تغییری نکرده است. که طبیعتاً این AISC360-05که مربوط به 

 و احتمالاً در ویرایش های بعدی اصلاح می گردد.

  در صورتی که ازETABS  برای طراحی تحت ترکیبات بار تشدید یافته استفاده کنید، این برنامه خود ترکیبات بار مربوطه را بصورت

 0.2و ضریب بار برف بام  0.5وان گفت که ضریب بار زنده داخلی می سازد. در ترکیبات بار پیش فرض ساخته شده در برنامه نمی ت

در نظر گرفته می شود که این امر موجب کمی غیراقتصادی طرح شدن ستونها  1.0اعمال گردد و ضریب بار همگی بارهای زنده 

 خواهد شد.

  در صورتی که بار زلزله قائم را بصورت یکLoad Case  از نوعQUAKE  در برنامهETABS کنیم و بجای آن، این اثر در تعریف ن

عمل شده است(، برنامه  99-152-1ضمیمه دستورالعمل شماره  ETABSترکیبات بارگذاری معرفی شوند، )مانند آنچه در فایل 

ETABS  .حالت بار زلزله قائم را وارد ترکیب بار تشدید یافته ای که خود بصورت داخلی می سازد نمی کند 
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 ستونها جهت کنترل تحت ترکیبات بار تشدید یافته Mn2و  Mn3وارد نمودن مقادیر زیاد برای  (22) شکل
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 استفاده می کنید، به نکات زیر دقت کنید: LRFDبرای طراحی سازه فولادی به روش  ETABS 2013در صورتی که از  (1

  همانطور که گفته شد، هر چند در برنامهETABS 2013  طراحی بر اساسAISC360-10  نیز اضافه شده است، اما مطابق

MANUAL  برنامه، طراحی هنوز بر اساس روال آئین نامهAISC360-05  صورت می گیرد. دقت کنید که در زمینه تمهیدات لرزه

 این عیب برطرف نشده بود.( 13.1.4ای این دو آئین نامه با یکدیگر تفاوت دارند. )تا ویرایش 

  بر خلاف نرم افزارETABS 9.7.4 پارامترهای لرزه ای در دو قسمت مختلف، یکی در منوی  کهDefine  و دیگری در منویOptions 

> Design Preferences  پرسیده می شد، درETABS 2013  تنها در قسمتDesign > Steel Frame Design > Design 

Preferences  لی برطرف شده است. اما ایرادی که در تمامی پارامترها پرسیده می شود. بنابراین نقص مربوطه در ویرایش قب

2013 ETABS  0موجود است آن است که هر مقداری برایΩ   در این قسمت معرفی شود برنامخ همواره این ضریب را در محاسبات

 Overwriteدر نظر می گیرد. برای رفع این مشکل کافی است کل سازه را انتخاب کرده و مقدار پارامتر مزبور را یک بار  9ود عدد خ

 این عیب برطرف نشده بود.( 13.1.4کنید.  )تا ویرایش 

  عیبی که در نرم افزارETABS 9.7.4  وجود داشت و در نرم افزارETABS 2013  برطرف شده آن است که در نرم افزار قبلی برنامه

ست طراحی اضافه می کرد که این امر همواره ترکیبات بار پیش فرض خود را علاوه بر ترکیبات بار انتخاب شده توسط کاربر به لی

برطرف شده است. هر چند در متن های قبلی بیان گردید که  ETABS 2013باعث کمی سنگین شدن سازه می شود. این عیب در 

نیز هر بار پس از تحلیل با حذف هم ترکیبات بار پیش فرض طراحی و هم ترکیبات بار پیش فرض  ETABS 9.7.4می توان در 

 بصورت تؤمان، این مشکل را برطرف کرد. کنترل خیز،

 

بطور اتوماتیک مقادیر سختی را کاهش می  ETABSدر طراحی،  Direct Analysisهمانطور که گفته شد در هنگام استفاده از روش  (4

داری غیر از روش بایستی مدلی دیگر داشت که روش طرح پای Driftطبقات افزایش می یابد. اما برای کنترل  Driftدهد. بنابراین مقادیر 

Direct Analysis  باشد. همیشه مقادیرDrift  دریفت ارائه شده در روش  %05واقعی مساوی یا کمتر ازDirect Analysis  .است

ضرب کرد. همچنین مقادیر  0.8را در عدد  ETABSبنابراین می توان برای کنترل دریفت بطور محافظه کارانه مقادیر دریفت ارائه شده در 

0.8√ارتعاش طبیعی سازه نیز تقریباً پریود  ≅  می باشد. Direct Analysisبرابر مقادیر ارائه شده در روش  0.9

 

با کاهش سختی، مقدار خیز تیرها نیز در تحلیل صورت گرفته بیشتر نشان داده می شود. اما خود برنامه در  Direct Analysisدر روش  (0

 کان واقعی استفاده می نماید و نیازی به انجام تغییر خاصی نیست.هنگام طراحی تیرها برای خیز، از مقدار تغییرم

 

در هنگام تحلیل سازه از سختی های کاهش یافته استفاده می شود. ولی در هنگام طراحی از همان سختی  Direct Analysisدر روش  (1

های واقعی استفاده می گردد. زیرا اثر کاهش سختی و غیر خطی شدن مصالح، در خود فرمولهای طراحی دیده شده اند. بطور مثال وقتی 

𝐹𝑒انش خمشی محاسبه نماییم، در فرمول اولر می خواهیم ظرفیت فشاری یک ستون را برای معیار کم =
𝜋2𝐸

𝜆2
 crFو یا در فرمول  ⁄

 کاهش نیافته استفاده می گردد. Eپیچشی از  -محاسبه ظرفیت تیرها برای کمانش جانبی

 

لرزه ای آئین برای آنکه برنامه بتواند ضوابط  OCBF ،IMF ، SMF  ،EBFدر صورت استفاده از سیستمهای لرزه ای موجود در برنامه مثل  (7

 Options>Prefrences>Steel Frame Designرا در قسمت  ?Ignore Seismic Codeنامه را کنترل نماید، می بایست گزینه 

 به نکات زیر توجه کنید:انتخاب کرد. در مورد کنترل های برنامه  Noگزینه 

  اثر ترکیبات بار شامل نیروهای نامتعادل مهاربندها تحت  نکنترل تیرهای مهاربند شوروبرای قابهای مهاربندی همگرای معمولی

بدین منظور می بایست در مدل  توسط برنامه صورت نگرفته و می بایست بصورت دستی و با ساختن مدل جداگانه صورت گیرد.
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 ه را در قسمتدیگری مقطع مهاربندهای شورن را با مقطعی بسیار ضعیف )مثلاً یک میلگرد( جایگزین نماییم. حالت های بار زلزل

Static Load Cases  نیزNone  انتخاب کنید تا بارگذاری اتوماتیک زلزله از روی سازه برداشته شود. سپس ظرفیت های کششی

(. پس از آن با فرض یک جهت برای  ntPو  ncPو فشاری این مهاربندها را با مشاهده مشخصات طراحی آنها یادداشت نمایید )مقادیر 

را در دو انتهای مهاربند  nc0.3Pرا در دو انتهای مهاربندهای شورون کششی و مقدار  ntPy=RgAyFyRلی، مقدار نیروی زلزله اعما

اعمال نمایید. بدین منظور عضو را انتخاب کرده و برای بارگذاری نقطه ای  به عنوان نیروی زلزله راستای مورد نظر شورون فشاری

استفاده نمایید. پس از آن تیرهای دهامه مهاربندی شورون را برای ترکیبات شامل  1در راستای محور محلی  Frameروی المان 

نیروی زلزله طرح نمایید. دقت کنید که در این حالت ممکن است بخاطر حذف مهاربندها سازه دچار مشکل ناپایداری شود. برای رفع 

ببندید. همچنین برای آنکه تیر دهانه  yو  xیاً مرکز جرم هر طبقه را در راستاهای را غیرفعال نمایید. ثان P-Dمشکل اولاً تحلیل 

ستون  -در نظر بگیرید. در این حالت تیر مورد نظر بصورت المان تیر Semi Rigidمهاربندی نیروی محوری ببرید، بهتر است سقف را 

 طراحی خواهد شد.

  تحت اثر ترکیبات بار شامل نیروهای نامتعادل مهاربندها توسط برنامه صورت  کنترل کل سازهبرای قابهای مهاربندی همگرای ویژه

بدین منظور مانند روشی که در حالت قبل گفته شد عمل  نگرفته و می بایست بصورت دستی و با ساختن مدل جداگانه صورت گیرد.

مهاربندها )نه فقط مهاربندهای شورون( بوده و  نمایید. با این تفاوت که نیروهای در کششی و فشاری در نظر گرفته شده برای تمام

 gAcr1.14Fو  ntPy=RgAyFyRمقادیر آنها نیز با مقادیر حالت قبل متفاوت است. نیروهای کششی و فشاری یک بار می بایست به ترتیب 

مختلف برای هر راستا می در نظر گرفته شود. بنابراین دو حالت زلزله  gAcr0.3x1.14Fو  ntPy=RgAyFyRو یک بار به ترتیب برابر 

. همچنین کل سازه شامل کل تیرها و کل ستونها می Xبرای راستای  EX2و دیگری  EX1بایست در نظر گرفته شود. مثلاً یکی 

بایست برای این نیروهای زلزله و ترکیبات بار ناشی از آنها طرح شوند )برخلاف سیستم مهاربندی همگرای سازه که فقط تیرهای 

 رون برای این نیروها طرح می شدند(.مهاربند شو

  برای قابهای خمشی با شکل پذیری متوسط و ویژه کنترل ضابطه برش نظیر تشکیل مفصل پلاستیک در دو انتها تیر صلب، توسط

بدین منظور می توانید مدل دیگری ساخته و تیرهای صلب را دو انتها  برنامه صورت نگرفته و می بایست بصورت دستی کنترل شود.

. بارگذاری زلزله را نیز از حالت اتوماتیک دو انتها عدد صفر اعمال کنید تمامی المانها را در End Offsetهمچنین مقدار مفصل نمایید. 

انتخاب کنید(. حال برای هر تیر مقدار لنگر را برای نیروهای زلزله  Noneگزینه  Static Load Casesبردارید )در قسمت 

yZFyRPRC=PMyRPRC پس از آن ظرفیت های  اعمال نمایید. به عنوان نیروی زلزله راستای مورد نظر را در دو انتهای تیرهای صلب

اص طراحی اعضاء فولادی اعداد بزرگی اختص Overwriteرا در قسمت  Mn2 , Mn3 خمشی تیرهای مورد نظر، یعنی مقادیر 

دهید. سپس برای ترکیبات بار شامل نیروی زلزله این تیرها را طراحی برشی کنید. در صورت ناپایدار شدن سازه از راه حلی که برای 

 قابهای مهاربندی همگرای معمولی ذکر شد استفاده نمایید.

 فقط برای وقتی صورت می گیرد که مقطع ستون  در برش کنترل کفایت چشمه اتصال برای قاب های خمشی متوسط و ویژهI/Wide 

Flange  .همچنین این کنترل فقط در راستای محور جان پروفیل ستون صورت می گیرد. در صورتی که ضخامت جان مقطع باشد

H  شکل جوابگو نباشد، برنامه ضخامت ورق مضاعف(Doubler Plate) ین ضخامت را در خروجی ها اعمال خواهد کرد. در محاسبه ا

نوع جوش این ورق به ورق جان ستون )جوش انگشتانه یا خیر( مهم است که می توان آن را در قسمت 

Options>Prefrences>Steel Frame Design  در سطرIs Doubler Plate Plug Welded? .مشخص نمود 

  ،فقط وقتی مقطع ستون برای قابهای خمشی ویژه کنترل ضابطه ستون قوی و تیر ضعیفI/Wide Flange  .باشد صورت می گیرد

یل مفصل پلاستیک در بر ستون است که تنها در صورت استفاده از اتصال گیردار مستقیم حالت برنامه فرض می کند محل تشک در این

(WUF-W) .این فرض صحیح است 
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  در تمام انواع قابهای خمشیOMF, IMF, SMF ر به ستون برای ستونهای با مقطع کنترل نیاز به سخت کننده ها در محل اتصال تی

صورت می گیرد و در صورت نیاز ضخامت ورق سخت کننده اعمال می شود. هر چند همواره استفاده از ورق  I/Wide Flengeنوع 

 سخت کننده ستون در مقابل اتصال صلب تیر به اندازه ضخامت بال مقطع تیر توصیه شده است.

  در قابهای خمشیIMF, SMF رل می کند که فاصله بین مهارهای جانبی هر دو بال تیر از برنامه کنتy E / F y0.17 r  برای قاب

و  y142 r به ترتیببرابر این اعداد ) بیشتر نشود قاب خمشی ویژه)نصف مقدار قبلی( برای   yE / F y0.086 rو   متوسطخمشی 

y71 r در صورتی که مقداری برای می بانشد .)(Minor)Unbraced Length Ratio   در قسمتOverwrite  وارد نشود، برنامه

برابر فاصله تیرچه های متصل به تیر مورد نظر فرض می کند. بنابراین اگر هم بال فوقانی و هم بال فاصله بین مهارجانبی تیرها را 

( وارد نمایید. 51/5 عددمثال  در سقف مدفون است، مثلاً سقف تیرچه بلوک است، این ضریب را عدد کوچکی )به عنوان تیرتحتانی 

یر تبرنامه آنقدر مقطع پروفیل  این حالتوارد ننمایید. در  هیچ ضریبی رادر غیر این صورت، برای سقف کامپوزیت و عرشه فولادی، 

ضابطه  بهتر این بودن بقیه مشخصات، مقاطع بال پهن تر مناسب تر با فرض ثابتتا ضابطه مزبور ارضاء شود.  هرا افزایش داد نظرمورد 

. اگر نخواهید با افزایش مقطع این ضابطه کنترل شود، می توانید از سینه بند برای بستن بال تحتانی تیر به سقف کردخواهند  را ارضاء

 وارد کنید. Unbraced Length Ratio (Minor)استفاده نموده و نسبت فاصله آنها را در قسمت 

در صورتی که سیستم سازه ای در یک جهت قاب خمشی و در جهت دیگر  برای این حالت ذکر یک نکته خالی از لطف نیست.

مهاربندی بوده و نوع سقف کامپوزیت یا عرشه فولادی باشد، برای آنکه ضابطه فاصله مهار جانبی دو بال تیر، حاکم بر طرح و افزایش 

 تا مهار مناسب جانبی را ایجاد نمایند.مقطع نگردد، مناسب تر است که تیرچه های سقف بر روی تیرهای قاب خمشی قرار گیرند 

  در صورت انتخاب قاب مهاربندی واگراEBF  برنامه تمامی کنترل های نیاز به فشردگی مقاطع، محاسبه تیر خارج پیوند، محاسبه

همچنین ستون کنار مهاربند، برای نیروهای اضافی ذکر شده در آئین نامه توسط خود برنامه صورت می گیرد. مهاربند و محاسبه 

کنترل دوران تیر پیوند نیز توسط برنامه انجام می پذیرد. تنها کاربر می بایست بر اساس میزان دوران تیر پیوند، فاصله سخت کننده 

های میانی را  تعیین کند که می توان بدون کنترل مقدار این دوران، ضوابط سخت گیرانه مربوط به فواصل سخت کننده ها، که برای 

 رفتار تیر پیوند برشی است، را اعمال نمود. وقتی است که
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